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• The information in this document is current as of December, 2009. The information is subject to 
change without notice. For actual design-in, refer to the latest publications of NEC Electronics 
data sheets or data books, etc., for the most up-to-date specifications of NEC Electronics 
products. Not all products and/or types are available in every country. Please check with an NEC 
Electronics sales representative for availability and additional information. 

• No part of this document may be copied or reproduced in any form or by any means without the prior 
written consent of NEC Electronics. NEC Electronics assumes no responsibility for any errors that may 
appear in this document. 

• NEC Electronics does not assume any liability for infringement of patents, copyrights or other intellectual 
property rights of third parties by or arising from the use of NEC Electronics products listed in this 
document or any other liability arising from the use of such products. No license, express, implied or 
otherwise, is granted under any patents, copyrights or other intellectual property rights of NEC Electronics 
or others. 

• Descriptions of circuits, software and other related information in this document are provided for 
illustrative purposes in semiconductor product operation and application examples. The incorporation of 
these circuits, software and information in the design of a customer's equipment shall be done under the 
full responsibility of the customer. NEC Electronics assumes no responsibility for any losses incurred by 
customers or third parties arising from the use of these circuits, software and information. 

• While NEC Electronics endeavors to enhance the quality, reliability and safety of NEC Electronics 
products, customers agree and acknowledge that the possibility of defects thereof cannot be eliminated 
entirely. To minimize risks of damage to property or injury (including death) to persons arising from 
defects in NEC Electronics products, customers must incorporate sufficient safety measures in their 
design, such as redundancy, fire-containment and anti-failure features. 

• NEC Electronics products are classified into the following three quality grades: "Standard", "Special" and 
"Specific". 
The "Specific" quality grade applies only to NEC Electronics products developed based on a customer-
designated "quality assurance program" for a specific application. The recommended applications of an 
NEC Electronics product depend on its quality grade, as indicated below. Customers must check the 
quality grade of each NEC Electronics product before using it in a particular application. 
"Standard": Computers, office equipment, communications equipment, test and measurement  
  equipment, audio and visual equipment, home electronic appliances, machine tools,  
  personal electronic equipment and industrial robots. 
"Special": Transportation equipment (automobiles, trains, ships, etc.), traffic control systems,  
  anti-disaster systems, anti-crime systems, safety equipment and medical equipment  
  (not specifically designed for life support). 
"Specific": Aircraft, aerospace equipment, submersible repeaters, nuclear reactor control  
  systems, life support systems and medical equipment for life support, etc. 

The quality grade of NEC Electronics products is "Standard" unless otherwise expressly specified in NEC 
Electronics data sheets or data books, etc. If customers wish to use NEC Electronics products in applications 
not intended by NEC Electronics, they must contact an NEC Electronics sales representative in advance to 
determine NEC Electronics' willingness to support a given application. 

(Note) 
(1) "NEC Electronics" as used in this statement means NEC Electronics Corporation and also includes its 
majority-owned subsidiaries. 
(2) "NEC Electronics products" means any product developed or manufactured by or for NEC Electronics (as 
defined above). 
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For customers in the European Union only 
 
Redemption of Waste Electrical and Electronic Equipment 
(WEEE) in accordance with legal regulations applicable in the 
European Union only: This equipment (including all 
accessories) is not intended for household use. After use the 
equipment cannot be disposed of as household waste. NEC 
Electronics (Europe) GmbH offers to take back the equipment. 
All you need to do is register at http://www.eu.necel.com/weee 

 
CAUTION 

 
This is a Test- and Measurement equipment with possibility to be significantly 
altered by user through hardware enhancements/modifications and/or test or 
application software. Thus, with respect to Council Directive 89/336/EEC 
(Directive on compliance with the EMC protection requirements), this equipment 
has no autonomous function. Consequently this equipment is not marked by the 
CE-symbol. 

 
EEDT-ST-005-10 

 
CAUTION 

 
This equipment should be handled like a CMOS semiconductor device. The 
user must take all precautions to avoid build-up of static electricity while 
working with this equipment. All test and measurement tool including the 
workbench must be grounded. The user/operator must be grounded using 
the wrist strap. The connectors and/or device pins should not be touched 
with bare hands. 

 
EEDT-ST-004-10
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Regional Information 
 
Some information contained in this document may vary from country to country. Before using any NEC 
product in your application, please contact the NEC office in your country to obtain a list of authorized 
representatives and distributors. They will verify: 
 

• Device availability 
• Ordering information 
• Product release schedule 
• Availability of related technical literature 
• Development environment specifications (for example, specifications for 

third-party tools and components, host computers, power plugs, AC supply 
voltages, and so forth) 

• Network requirements 
 
In addition, trademarks, registered trademarks, export restrictions, and other legal issues may also vary 
from country to country. 
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1. Introduction 
 
V850ES/Jx3-E - Network it!  is an Ethernet and USB demonstration kit for the NEC V850 32-bit 
microcontroller family. It allows the development of an Ethernet and/or USB system based on the 
V850ES uPD70F3783 device. It supports on-board debugging and real time execution of application 
programs.  

1.1 Main features of V850ES/Jx3-E - Network it! 

 
• Easy to use device demonstration capabilities 

V850ES/Jx3-E - Network it! contains elements to easily demonstrate simple I/O-functions, i.e. I/O 
lines, Ethernet interface, USB interface, analog inputs and outputs, UART serial interface etc. 

 
• On-Board debug function 

The V850ES/Jx3-E - Network it! supports an On-Board debug function by using the IAR C-SPY 
debugger without a need of additional debug hardware. It allows FLASH downloading and standard 
debug functions like code execution, single stepping, breakpoints, memory manipulation etc. 

 
• Power supply by USB interface or via external power supply 
 
• Various input / output signals and communication capabilities available, such as 
 

° Seven Segment LED 
° Two switches prepared for key interrupt generation 
° CAN interface 
° Ethernet interface 
 

• The IAR Embedded Workbench for V850 and the IAR C-SPY debugger / simulator are included. 
These packages are restricted in such that maximum program code size is limited to 64 KB. 

 
• Full documentation is included for the NEC V850ES uPD70F3783 microcontroller, IAR Systems 

Embedded Workbench and IAR Systems C-SPY debugger / simulator. 
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1.2 System requirements 

 
Host PC A PC supporting Windows 2000, Windows XP or Windows Vista is 

required for the IAR Systems Embedded Workbench demo-version.  
A Pentium processor with at least 1 GHz CPU performance, with at least 
256 Mbytes of RAM, allowing you to fully utilize and take advantage of the 
product features. 500 Mbytes of free disk space and an additional 10 
Mbytes of free disk space on the Windows system drive. 
 
A web browser and Adobe Acrobat Reader to be able to access all the 
product documentation. 

Host interface USB interface that enables communication based on USB (Ver1.1 or 
later) 
Ethernet interface that enables communication based on IEEE802.3 
norm. 
100BASE-TX/10BASE-T (For sample program execution) 
 
Network Settings (recommended): 
IP Address: 192.168.0.10 
NetMask : 255.255.255.0 

 

1.3  Package contents 

 
Please verify that you have received all parts listed in the package contents list attached to the              
V850ES/Jx3-E - Network it!  package. If any part is missing or seems to be damaged, please contact the 
dealer from whom you received your V850ES/Jx3-E - Network it!. 
 
Note: Updates of the IAR Embedded Workbench for V850 documentation and/or utilities for 

V850ES/Jx3-E - Network it!, available, may be downloaded from the NEC WEB page(s) at 
http://www.eu.necel.com/update/index.html?id=323 

 

1.4 Trademarks 

 
IAR Embedded Workbench, visualSTATE, IAR MakeApp and C-SPY are registered trademarks of IAR 
Systems AB. Microsoft and Windows are registered trademarks of Microsoft Corporation. Adobe and 
Acrobat Reader are registered trademarks of Adobe Systems Incorporated.  
 
All other product names are trademarks or registered trademarks of their respective owners. 

http://www.eu.necel.com/update/index.html?id=323
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2. V850ES/Jx3-E - Network it! System Configuration 
 
The V850ES/Jx3-E - Network it!  system configuration is given in the diagram below: 
 

 
Figure 1: V850ES/Jx3-E - Network it! System Configuration 

 

2.1 V850ES/Jx3-E - Network it! 

 
V850ES/Jx3-E - Network it!  is an Ethernet and USB demonstration kit for the uPD70F3783 32-bit 
microcontroller of the V850 family. The demonstration board is connected to the host system via USB 
interface cable. The host system may be used for On-Chip debugging by using the IAR C-SPY debugger 
and to allow execution of application programs on the V850ES/Jx3-E - Network it!  starter kit. 
 

2.2 Host computer 

 
The USB host interface enables communication to the V850ES/Jx3-E - Network it!  board. The 
µPD78F0730 78K0 8-Bit microcontroller with on-chip USB interface and the NEC virtual UART driver 
allows application software to access the USB device in the same way as it would access a standard 
RS232 interface.  
The NEC virtual UART driver appears to the windows system as an extra Com Port, in addition to any 
existing hardware Com Ports.  
 

2.3 Power supply via USB interface 

 
The V850ES/Jx3-E - Network it!  board is powered by the USB interface. Optional the power supply can 
be applied via the connector CN4. 
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3. V850ES/Jx3-E - Network it! Hardware 

3.1 Hardware Components 
 

The V850ES/Jx3-E - Network it! board is equipped with Ethernet and USB connectors and with several 
connectors in order to be connected to host computers, FLASH programmer or any external target 
hardware. 
 
 

 
Figure 2: V850ES/Jx3-E - Network it! Connector Layout 
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Figure 3: V850ES/Jx3-E - Network it! Function Layout 

 
 
Some of the V850ES/Jx3-E - Network it! components are free for user application hardware and software. 
Please read the user’s manual of the uPD70F3783 device carefully to get information about the electrical 
specification of the available I/O ports before you connect any external signals to the V850ES/Jx3-E - 
Network it! board. 
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3.1.1 SW1, Configuration switch (DIP-Switch) 

 
The different operation modes of the V850ES/Jx3-E - Network it!  board can be set by switch SW1. The 
bits 1-4 of DIP switch SW1 are for the mode setting of the board, bits 5-8 are connected to the pins 
“P76/ANI6”, “P77/ANI7”, “P78/ANI8” and “P79/ANI9” of the V850 microcontroller and can be used for user 
application purpose. 
 
The V850ES/Jx3-E - Network it!  starter kit can be used in the following operation modes: 

 
- On-Board debug mode 

o Start a debug session using the On-Board debug interface  
 

- Flash-Programming Mode 
o Program an application to the build-in flash memory of  uPD70F3783 by WriteEZ5-

programmer 
 

- Stand alone mode 
o Run a program stored in built-in flash memory of the uPD70F3783 device 
 

- N-Wire debug mode 
o Start a debug session using an N-Wire emulator, e.g. MINICUBE 

 
- Virtual serial COM port mode 

o In this mode USB can be used as virtual serial COM port. 
 

 

SW1 / bit 
On-Board 

Debug Mode 

Flash 
Programming

Mode 

Stand alone 
Mode 

 N-Wire 
Debug Mode 

Virtual serial 
COM port 

Mode 
1 OFF OFF OFF OFF OFF 
2 ON ON OFF OFF OFF 
3 ON ON OFF OFF OFF 
4 ON ON ON ON ON 

Table 1: Mode Setting, Switch SW1 

 
Note:  After changing the configuration of SW1 bits 1-4 it is necessary to power-up the  

V850ES/Jx3-E - Network it! board to make changing active. This can be done by simply 
disconnecting and reconnecting the USB interface cable. 
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3.1.2 SW2, RESET button 

 
SW2 is the reset button and controls the reset input signal of the V850ES/Jx3-E - Network it! 
microcontroller. 
 

3.1.3 SW3, Switch (INTP17) 

 
SW3 is a push button connecting VSS to external interrupt input INTP17 of the microcontroller. This is 
equal to port ”P98/TENC01/INTP17/A8” of the uPD70F3783 device. The port may be programmed to 
generate the external interrupt INTP17. The necessary initialization for this purpose is described in the 
user’s manual of the uPD70F3783 device. 
 

3.1.4  SW4, Switch (INTP18) 
 

SW4 is a push button connecting VSS to external interrupt input INTP18 of the microcontroller. This is 
equal to port ”P912/TOAB1OFF/INTP18/A12” of the uPD70F3783 device. The port may be programmed 
to generate the external interrupt INTP18. The necessary initialization for this purpose is described in the 
user’s manual of the uPD70F3783 device. 
 

3.1.5 JP1, Power Supply selector 

 
Jumper JP1 is the power supply selector of the V850ES/Jx3-E - Network it! board. 
 

JP1 Power Supply Source 

1-2 short USB connector USB1 
3-4 short USB connector USB2 (built-in USB function controller) 
5-6 short AC/DC adapter via connector CN4 

Table 2: Power Supply Selector, JP1 

 
Note:  If multiple connections made to USB1, USB2 and CN4/J1, set JP1 to the preferred power  
 supply route. 
 
 

3.1.6 LED1, Power LED 

 
LED1 is the power LED of the V850ES/Jx3-E - Network it! board. It indicates if power is applied to the 
V850ES/Jx3-E - Network it! board. 
 
 

3.1.7 LED2 and LED3, Ethernet status LEDs 

 
LED2 and LED3 indicate the status of the Ethernet transceiver of the V850ES/Jx3-E - Network it! board. 
 

 Silkscreen Function 

LED2 LINK Indicates a connection 
LED3 ACTIVITY Indicates the activity 

Table 3: Ethernet Status LEDs, LED2 and LED3 
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3.1.8 CN1, Extension connector (not assembled) 

 
CN1 is a 100-Pin extension connector (FX8C-100P-SV6 by Hirose Electric Co., Ltd.) and can be used to 
connect additional external hardware to the V850ES/Jx3-E - Network it! board. 
 

3.1.9 CN4, AC power supply connector 

 
CN4 is the AC power supply connector of the V850ES/Jx3-E - Network it! board. Please connect only a 
power supply with an output of maximum +5V DC to the board. 
 
 

JACK Input 
Centre VDD (+5V) 
Ring GND 

Table 4: CN4 Connector 

 

3.1.10 CN5, Extension connector (not assembled) 

 
CN5 is a 30-Pin extension connector (DF17(3.0)-030DS-0.5V(57) by Hirose Electric Co., Ltd.) and can be 
used to connect additional external hardware to the V850ES/Jx3-E - Network it! board. 
 

3.1.11 J1, Optional power supply connector (not assembled) 

 
J1 is an optional connector for an external power supply. Please connect only a power supply with an 
output of maximum +5V DC to the board. 
 

3.1.12 FP1, MINICUBE2 connector (not assembled) 

 
FP1 (not assembled, solder pads) allows connecting a MINICUBE2 to the V850ES/Jx3-E - Network it! 
board. 
 

3.1.13 CAN1, CAN interface connector (not assembled) 

 
The 9-Pin D-Sub connector allows serial communication following the CAN protocol. 
CAN0 module of the uPD70F3783 will be used for communication. 
 

3.1.14 TR1, RJ-45 connector 

 
RJ-45 connector socket (TDK TLA-6T718) which allows using the Ethernet functionality of the 
V850ES/Jx3-E - Network it! board. It is connected to the 10/100 Ethernet transceiver, LAN8700C. 
 

3.1.15 NWIRE1, N-Wire connector 

 
Connector NWIRE1 allows connecting an N-Wire On-Chip debug emulator, e.g. MINICUBE, to the 
V850ES/Jx3-E - Network it! board. Please note, the QB-V850MINI On-Chip debug emulator is a separate 
product from NEC and it is not included in this starter kit package.  
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3.1.16 U3, Seven-segment-LED 

 
The seven-segment-LED U3 is connected to the port 9 bits 0-7 of the uPD70F3783. Output a zero to light 
the corresponding segment. 

 
Figure 4: Seven-Segment-LED U3 

 
To display the characters ‘0’ to ‘9’ output the following values to the pins of port 9: 
 
  

Character  Value 
0 0xC0 
1 0xF9 
2 0xA4 
3 0xB0 
4 0x99 
5 0x92 
6 0x83 
7 0xF8 
8 0x80 
9 0x98 

Table 5: Display Examples 

 

Bit0 

Bit1 

Bit2 

Bit3 

Bit4 

Bit5 

Bit6 

Bit7 
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3.1.17 USB1, Debug connector (Type Mini-B) 

 
This interface allows connecting the IAR C-SPY debugger to the V850ES/Jx3-E - Network it! board in 
order to use the On-Board debug function. The interface supports On-board FLASH erasing / 
programming and standard debug features like code execution, single stepping, breakpoints, memory 
manipulation etc. 
 
The power supply of the V850ES/Jx3-E - Network it! board is also provided by the USB1 connector. 
 

1 5

 
Figure 5: USB1, USB Mini-B Type Host Connector Pin Configuration 

 
 

Connector USB1 Signal Name 
1 VBUS 
2 D- 
3 D+ 
4 ID_NC 
5 GND 

        Table 6: Pin Configuration of Connector USB1 

 
For connection with the host machine, use a USB cable (Mini-B type). For confirmation, NEC Electronics 
used only the USB cable delivered with the V850ES/Jx3-E - Network it! board. 
 
 
 

3.1.18 USB2, Universal serial bus connector (Type Mini-B) 

 
The interface allows connecting the built-in USB function controller of the uPD70F3783 with a host 
system. It is also possible to provide the power supply of the V850ES/Jx3-E - Network it! board by the 
USB2 connector. 
 
For connection with the host machine, use a USB cable (Type Mini-B). For confirmation, NEC Electronics 
used only the USB cable delivered with the V850ES/Jx3-E - Network it! board. 
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3.2 Layout of solder-short pads 

 
Several pins of the uPD70F3783 microcontroller are connected to solder short-pads. The pads can be 
opened by the user to add user specific functions. The signal connected to each solder-short pad is 
printed on the V850ES/Jx3-E - Network it! board. To open a circuit, cut the narrow part of the pad with a 
knife. To short a circuit again, join the separated pad with a soldering iron. 
 

 
Figure 6: Solder-short pad shortened shape 

 

 
Figure 7: Solder-short pad opened shape 

 
 

Solder-short pad 
name 

Shipping state Connection 

T_RESET Short 
U1 Pin4 to T_RESET 
Open when the on-board Reset Circuit is not used. 

P90 - P97 Short 
7-segment LED 
Open when using it for other purposes 

FLMD0 Short 
FLMD0 to CPU port P37 
Open pad if flash self-programming is not used. 

AVREF0 Short 
AVREF0 to VDD 
Open when AVREF0 is driven by other voltages 

DCVDD1,2 Short 
Regulator output to VDD 
Open when you supply the power from CN1 

UVDD Short 
UVDD to VDD 
Open when UVDD is driven by other voltages 

TXD Short Open when P90 is used for other purposes 

RXD Short Open when P91 is used for other purposes 

P76 - P79 Short 
Bits 5-8 of SW1 
Open when P76 – P79 are not used for general-
purpose input SW 

P98 Short 
P98 to SW3 
Open when using it for other purposes 

P912 Short 
P912 to SW4 
Open when using it for other purposes 

P42 Short 
P42 to USB D+ pull-up signal pin 
Open when you do not use USB D+ pull-up signal 

P41 Short 
P41 to USB D+ pull-up enable signal pin 
Open when you do not use USB D+ pull-up enable 
signal 

       Table 7: Solder-Short Pad Connection
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4. On-Chip Debugging 
 
The V850ES/Jx3-E - Network it! board offers three possibilities to use On-Chip Debugging (OCD). The 
On-Board debug function of V850ES/Jx3-E - Network it! allows On-Chip debugging without a need of 
external debug hardware. Within this mode the default USB connection to the Host computer based on 
the virtual UART driver is used as debug interface. All standard debug functions are available in the On-
Board debugging mode like FLASH programming / downloading, code execution, single stepping, 
breakpoints, memory manipulation etc. 
 
Additionally V850ES/Jx3-E - Network it! supports the QB-V850MINI On-Chip debug emulator in order to 
use On-Chip debug function of the uPD70F3783 device.  
 
Finally, V850ES/Jx3-E - Network it! also supports the MINICUBE2 On-Chip debugger to benefit from the 
On-Chip debug function of the uPD70F3783 device. Nevertheless, the connector for MINICUBE2, FP1, is 
not assembled on the board. 
 
The system configuration for On-Chip debugging is shown in figure below (OCD via MINICUBE2 is not 
shown in this figure as the connector is not provided). 
 
 
 
 
 

 
 
 

Figure 8: On-Chip Debugging 
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4.1 OCD via On-Board debug function 

 
To operate the V850ES/Jx3-E - Network it! board within the On-Board debug mode, configure switch 
SW1 bits 1-4 as following: 
 

SW1/bit Configuration 
1 OFF 
2 ON 
3 ON 
4 ON 

Table 8: OCD via On-Board Debug Function 

 
Note:  To use the On-Board debug interface, the installation of an update package is needed. 

This update package can be found in the directory \MQB2 Monitor Update\ and can be 
installed by clicking on the installer file MQB2_monitor_update_v100.exe, containing the 
latest Monitor files and Exec-DLL files. 

 
 This update package is also needed when the MINICUBE2 is used for on-chip debug 

through the FP1 connector (which is not assembled). 
 
 
 

4.1.1 Resources used by On-Board OCD Interface 

 
Debugging via the On-board OCD Interface uses the user memory spaces to implement communication 
with the target device, or each debug functions. Refer to the following descriptions and secure these 
spaces in the user program. For more information about the On-Chip Debug Function please refer to the 
hardware user’s manual of the uPD70F3783.  
 
- Addresses 0x00000060 – 0x00000063:  Interrupt vector of debug monitor 

   This area is automatically reserved. 
   It is not allowed to use this area for any application segment.  

 
- Addresses 0x000004F0 - 0x000004F3:   Interrupt vector of UARTC0 

UARTC0 is used for the communication with the debugger  
and must be reserved 

   It is not allowed to use this area for any application segment.  
 
- Addresses 0x00000070-0x00000079  Security ID 

The security ID must be defined to configure the OCD Interface. 
Details are described in the uPD70F3783 user’s manual. 

 
- Addresses 0x0007F800 – 0x0007FFFF:            2K Debug Monitor area (ROM) 

   This area must be reserved in the linker control file (*.xcl). 
   It is not allowed to use this area for any application segment. 

 
- Addresses 0x03FFEFF0 – 0x03FFEFFF:           16 Bytes Debug Monitor area (RAM) 

       This area must be reserved in the linker control file (*.xcl). 
       It is not allowed to use this area for any application segment. 
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Figure 9: V850 OCD Interface Resources 

 
 
 

4.2 OCD via N-Wire emulator 

 
To operate the V850ES/Jx3-E - Network it! board together with an N-Wire On-Chip debug emulator, e.g. 
QB-V850MINI, connected to NWIRE1, configure switch SW1 bits1-4 as following: 
 
 

SW1/bit Configuration 
1 OFF 
2 OFF 
3 OFF 
4 ON  

Table 9: OCD via QB-V850MINI Emulator 
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4.3 OCD via MINICUBE2 On-Chip debugger 

 
To operate the V850ES/Jx3-E - Network it! board together with the MINICUBE2 On-Chip debugger, 
connected to FP1 (not assembled), configure switch SW1 bits1-4 as following: 
 
 

SW1/bit Configuration 
1 OFF 
2 ON 
3 ON 
4 ON 

Table 10: OCD via MINICUBE2 Emulator 

 
Note:  To use the MINICUBE2 On-Chip debugger, the installation of an update package is needed. 

This update package can be found in the directory \MQB2 Monitor Update\ and can be 
installed by clicking on the installer file MQB2_monitor_update_v100.exe, containing the 
latest Monitor files and Exec-DLL files.
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5. V850ES/Jx3-E - Network it! Installation and Operation 

5.1 Getting started 

 
The IAR Embedded Workbench including the C-SPY debugger allows building and downloading 
application programs to the V850ES/Jx3-E - Network it! starter kit. As communication interface between 
the PC host system and the V850ES/Jx3-E - Network it! board a standard USB interface line is needed. 
Before you can download and run a program, software and hardware have to be installed properly. 

 

5.1.1 CD-ROM contents 

 
The CD-ROM shows following directory structure: 
 
 

 V850ES/Jx3-E - Network it! CD-ROM ROOT 

  Acrobat - Acrobat Reader for 32Bit Windows OS 
 

  Device File Package - Device File Package for V850ES/Jx3-E 
 

  Documentation - Documentation 
 

  Driver - USB Driver 

  IAR  - IAR Embedded Workbench for V850 (64KB 
code limited) 

 

  MQB2 Monitor Update - Update package with the latest Monitor and 
Exec-DLL files needed for on-chip debug via 
the on-board debug interface and 
MINICUBE2 

 

  Sample Programs - Ethernet sample programs for V850ES/Jx3-E 
- Network it! including: 

o HTTP web server demo 
o SMTP/POP3 e-mail client demo 
o DHCP client demo 
o 7-segment LED control demo 

 

  Segger - Segger USB and Ethernet Eval Package 
 

  WriteEZ5 - Flash Programmer WriteEZ5 incl. PRM files 
for uPD70F3783 

 

Table 11: V850ES/Jx3-E - Network it! CD-ROM Directory Structure  
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6. Hardware Installation 
 
After unpacking V850ES/Jx3-E - Network it!, connect the board via connector USB1 to your host computer 
using the provided USB interface cable. When V850ES/Jx3-E - Network it! is connected, the USB driver 
needs to be installed on the host machine. Please refer to the following chapter 7.5 USB Driver Installation. 
 

7. Software Installation 
 
The V850ES/Jx3-E - Network it! package comes with the following software packages: 
 
• IAR Systems Embedded Workbench for V850, including C compiler, assembler, linker, librarian and IAR 

C-SPY debugger / simulator 
 
• NEC Ethernet Sample Programs 
 
• Segger USB and Ethernet Eval Package 
 
• WriteEZ5 Flash Programmer Software including the PRM file for μPD70F3783  
 
The IAR Systems Embedded Workbench must be installed on your PC. For detailed installation hints, refer 
to the following chapters and to the corresponding documentation of the IAR Embedded Workbench. 
 
 

 
Figure 10: V850ES/Jx3-E – Network it! CDROM autorun.exe 
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7.1 IAR Systems Embedded Workbench for V850 installation 

 
To install the IAR Systems Embedded Workbench for V850 including C-SPY debugger / simulator, select the 
AUTORUN program in the directory \IAR\ of the CDROM. The setup dialogues will guide you through the 
installation process. 
 

7.2 Device File Package installation 

 
To use the IAR Embedded Workbench for V850 together with the uPD70F3783, you have to install the latest 
device files. You will find the installer for the Device file package on the V850ES/Jx3-E - Network it! CD. 
Select the file Setup_V850ES-Jx3-E_V1.00.exe in the directory \Device File Package\. The setup 
dialogues will guide you through the installation process. 
 

 

 
Figure 11: Device File Installation 

 
 

7.3 Sample program installation 

 
To install the Ethernet sample programs for the V850ES/Jx3-E - Network it! board copy the full \Sample 
Programs\ directory of the CD-ROM on your PC. 
 
 

7.4 Segger USB and Ethernet Eval Package installation 

 
To install the Segger USB Eval Package for the V850ES/Jx3-E - Network it! board select the 
SeggerEval_V850ES_NETWORKIT.exe  in the directory \Segger\ on the CDROM. The setup dialogues 
will guide you through the installation process. After the installation you will find a detailed documentation of 
the Segger USB Eval Package in the installation directory. 
 
 
 
 
 
 
 
 

Select the package 
for EWV850 3.xx 
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7.5 USB Driver installation 

 
In order to use the V850ES/Jx3-E - Network it! board for On-Chip debugging the USB driver needs to be 
installed on the host machine. Install the driver according to the following procedure: 

Installation on Windows 2000 ......................................  Page 29 
Installation on Windows XP .........................................  Page 32 
 
 Note:  The USB driver is part of the IAR Embedded Workbench software package. Therefore 
            please install the IAR Embedded Workbench first. 
 

7.5.1 Installation on Windows 2000 

 
1. When the V850ES/Jx3-E - Network it! board is connected with the host machine, the board 

is recognized by <Plug and Play>, and the wizard for finding new hardware is started.  Click 
Next>. 

 
Figure 12: Found New Hardware Wizard (Windows 2000) 

 
2. Following the window below is displayed. So, check that "Search for a suitable driver ..." is 

selected, then click Next>. 

 

Click. 
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Figure 13: Search Method (Windows 2000) 

 
 
 
 

3. Check the "Specify a location" check box only, then click Next>. 

 

 
            Figure 14: Driver File Location (Windows 2000) 

 
 
 
4. Locate the folder " \Driver” on the CD-ROM. 

 
5. The setup information file “MQB2SALL.inf” is automatic selected, then click Open to 

proceed within driver installation. 

 

Check that "Search for a 
suitable driver ..." is selected. 

Check that "Specify a 
location" only is checked. 

Click. 

Click. 
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Figure 15: Address Specification 2 (Windows 2000) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

6. After the location of the USB driver has been specified click OK to proceed. 
 

5. Click Next>. 

 

 
Figure 16: Driver File Search (Windows 2000) 

 
 
 
 

 
6. Click Finish to complete the installation of the USB driver. 

Click. 

Click. 
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Figure 17: USB Driver Installation Completion (Windows 2000) 

 
 

 
 

Click. 
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7.5.2 Installation on Windows XP 

 
1. When the V850ES/Jx3-E - Network it! board is connected with the host machine, the 

board is recognized by Plug and Play, and the wizard for finding new hardware is started. 
At first the hardware wizard will ask if windows should search on the windows update 
web, check "No, not this time" and then click Next>. 

 

 
Figure 18: Found New Hardware Wizard 1 (Windows XP) 

 
 

2. Check that "Install from a list or specific location (Advanced)" is selected, then click 
Next>. 

 
 

 
Figure 19: Found New Hardware Wizard 2 (Windows XP) 

 

 

 

Check that "No, not this time" 
is selected. 

Check that "Install from a list or 
specific ..." is selected. Click. 

Click. 
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3. Check that "Search for the best driver in these locations." is selected. Select the "Include 

this location in the search:" check box and then click Browse. 
 

 

Figure 20: Search Location Specification 1 (Windows XP) 

 
4. Locate the folder "\Driver” on the CD-ROM. 
 
5. After the location of the USB driver has been specified click Next> to continue driver 

installation. 
 

 

Figure 21: Search Location Specification 2 (Windows XP) 

 

<1> Check that "Search for the 
best driver in these locations." 
is selected. 

<2> Check "Include this 
location in the search:" 
only. 

<3>  Click. 

Click. 
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6. As shown below, "NEC Electronics Starter Kit Virtual UART has not passed Windows 
Logo testing to verify its compatibility with Windows XP." is displayed. Click Continue 
Anyway. 

 
 

 

Figure 22: Windows XP Logo Testing (Windows XP) 

 
7. After the installation of the USB driver is completed the window below is displayed. Click 

Finish to close the hardware wizard. 
 
 

 

Figure 23: USB Driver Installation Completion (Windows XP) 

 

 
 
 
 
 

Click. 

Click. 



V850ES/Jx3-E – Network it! 

 User’s Manual U20192EE1V0UM00 36 

 

7.6 Confirmation of USB Driver installation 

 
After installing the USB driver, check that the driver has been installed normally, according to the procedure 
below. When using the V850ES/Jx3-E - Network it! board in combination with IAR C-SPY debugger the 
“NEC Electronics Starter Kit Virtual UART” should be present like in the figure below. 
 
 
Please check in the Windows "Device Manager" within the Windows Properties (“Hardware” tab), that the 
driver is installed normally. 

 

               
Figure 24: Windows Device Manager 

 
 

Check that "NEC Electronics 
Starter Kit Virtual UART (COM?)" 
is present. 
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8. IAR Sample Session 
 
When everything is set up correctly the IAR Embedded Workbench can be started. To do so, start the 
Embedded Workbench from Windows “Start” menu > “Programs” > folder “IAR Systems” > “IAR Embedded 
Workbench Kickstart for NEC V850”. The following screen appears: 
 

 
Figure 25: IAR Embedded Workbench 

 
Now select the option “Open existing workspace” from the “File” menu and locate the following sample 
project folder, \Sample Programs\TK-850_Jx3-E_IAR_mailSample\Program Files\NEC 
Electronics Tools\smp850e\cnet\TK-850_Jx3-E\OSless, and open the file “cnet.eww”. This is 
the workspace file that contains general information about all sample projects and corresponding settings. 
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After the sample workspace has been opened the structure of the workspace is displayed. The screen 
should now look similar to this one: 
 

 
Figure 26: IAR Embedded Workbench Project Workspace 

 
As a next step check some settings of the IAR Embedded Workbench that have to be made for correct 
operation of the demonstration sample programs and usage of the On-Board debug function of the  
V850ES/Jx3-E - Network it! board. First highlight the project folder called “cnet – Debug” in the workspace 
window. Then select “Project” > “Options” from the pull-down menus. Go to “General Options” and select the 
device uPD70F3783 (V850ES  V850ES – Jx3-E  V850ES - uPD70F3783).  
 

 
Figure 27: Device Selection 
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It is necessary to tell the compiler where the additional Header files of the demonstration samples are 
located. Select the category “C/C++ compiler” and then the tab “Preprocessor”. Now the additional Include 
path can be added to the field “Additional include directories”. 
 

 

 
Figure 28: Include Directory 

 
As next step select the category “Debugger”. Make sure that the driver is set to “MINICUBE”. After this 
select the category “MINICUBE” down below and tick the box “Use MINICUBE2 (MINI2)” in order to use the 
On-Board debug function of the V850ES/Jx3-E - Network it! board. 
 
The corresponding port where the V850ES/Jx3-E - Network it! board is connected to the host PC will be 
detected automatically by the IAR C-SPY debugger. 
 
 

  
Figure 29: IAR Debugger Options 

Select “Use MINICUBE2” to 
use On-Board debugging. 

Add additional  
Include directories 
here
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Note:  Although the On-board debug interface is used, the MINICUBE2 C-Spy driver must be 

selected instead of the standard driver TK-V850 used for other starter kits. If the debug 
session via MINICUBE (QB-V850MINI) and the N-Wire connector shall be started, the 
MINICUBE C-Spy driver must be selected. 

 
 
Next the correct linker settings of the demo project will be checked. This can be done in the “Linker” 
category as shown below. Select the “Config” tab and check that the linker command file “lnk70F3760.xcl” is 
selected. This file is used by the linker and contains information on where to place the different sections of 
code, data and constants that may be used within the demo project: 
 
 

 
Figure 30: Embedded Workbench Linker Configuration 

 
Now after everything has been setup correctly it’s time to compile and link the demonstration project. Close 
the Options menu and select “Rebuild All” from the “Project” menu. If the project is compiled and linked 
without errors or warnings it can now be downloaded to the V850ES/Jx3-E - Network it! board and debugged.  
 
To start the IAR C-SPY debugger select the option “Debug” from the “Project” menu or press the (        ) 
“Debugger” button.  
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In the next step the Emulator has to be configured before downloading a new application. Press the OK 
button to enter the emulator hardware setup. Set the configuration as show in the figure below and start the 
download by pressing the OK button. 
 
 

                                                                   
Figure 31: MINICUBE Hardware Setup Dialogue 

 
Now the debugger is started and the demo project is downloaded to the V850ES/Jx3-E - Network it! board. 
The progress of downloading is indicated by a blue bar in the MINICUBE Emulator window. Please note that 
downloading of larger executables may take some time. 
 
After the download was completed all debug features of IAR C-SPY debugger are available, i.e. Single 
Stepping, Step Over/-In/-Out, Go-Execution, Breakpoints, Register / Memory view etc.  
To run the sample application select the option “Go” from the “Debug” menu or press the (        ) “Go” button. 
 
To get more details on the debugger configuration and capabilities please refer to the “IAR Embedded 
Workbench IDE User Guide” of the IAR installation. 

Set the main oscillator  
frequency to 6MHz 
with multiply rate 8 and 
sub-oscillator freq. to 
32.768kHz 
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Figure 32: IAR C-SPY Debugger 

 
 
 

9. Troubleshooting 
In some cases it might happen that the connection to the V850ES/Jx3-E - Network it! board can not be 
established. This can be caused by the following three situations: 
 

• Wrong security ID: The security ID is required to prevent the FLASH memory of the uPD70F3783 
microcontroller from being read by an unauthorized person. The security ID is located in the internal 
flash memory at addresses 0x0070-0x0079 of the uPD70F3783 microcontroller. The IAR C-SPY 
debugger starts only when the security ID that is set during debugger start-up and the security ID 
set at addresses 0x0070 to 0x0079 do match. In the above mentioned case it is necessary to erase 
the internal flash memory of the uPD70F3783 microcontroller to restore the security ID. Details 
about erasing and programming the internal flash memory of the uPD70F3783 are described in  
chapter 10 “Flash Programmer WriteEZ5” 

 
• Wrong Emulator Driver:  Make sure that the driver in the category “Debugger” of the project 

options menu is set to “MINICUBE”. After this select the category “MINICUBE” down below and tick 
the box “Use MINICUBE2 (MINI2)” in order to use the right driver settings for the 
V850ES/Jx3-E - Network it! board. 

 
• Wrong Oscillator Frequency:  Make sure that the clock settings in the Emulator Hardware Setup 

fit to the used oscillators on the board. In case of V850ES/Jx3-E - Network it! the main oscillator 
frequency is 6 MHz with multiply rate 8. The sub-oscillator frequency is 32.768 kHz. 
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10. Flash Programmer WriteEZ5 
 
The Flash programmer WriteEZ5 doesn’t need to be installed, but can be directly started from the CD-ROM. 
The Hex file, web_server_no_DHCP_192_168_0_5.hex, contains the sample programs and is provided 
in the \Sample Programs\ directory of the CD-ROM. The file is ready to be programmed to the Flash 
memory of the uPD70F3783 device after loading it using the “Load” button. 
  

 
Figure 33: WriteEZ5 User Interface 

10.1 Device Setup 

 
To provide all necessary information about the device to be programmed, only the corresponding flash 
parameter file must be loaded. The parameter file (*.prm) for the uPD70F3783 is located on the CD-ROM in 
the folder \WriteEZ5\PRM-70F3786_E100C\. Please use the menu “Device -> Setup…“ to open the 
following dialogue and the button “PRM File Read” to select the parameter file. Select the file 
70F3783_CSI0.prm. 
 

 
Figure 34: WriteEZ5 Device Setup Dialogue 

 
Please check that the correct host communication port is selected. The used communication port can be 
seen in the Windows Device Manager.  
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10.2 Using WriteEZ5 

 
After a successful device selection the internal flash memory can be blank-checked, erased, programmed or 
verified. WriteEZ5 can be controlled either by menu or by buttons 
 
 

 
Figure 35: WriteEZ5 Device Menu 

 
 

 
device setup button 

 
load file button 

 
blank check button 

 
erase button 

 
program button 

 
verity button 

 
erase / program / verify button 

Table 12: WriteEZ5 Action Buttons 

 
WriteEZ5 supports Intel-Hex and Motorola S-record file formats as input file.
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11. Ethernet Sample Programs 

11.1 General introduction 

 
All Ethernet sample programs are located in a single source code which can be found in the following 
directory of the CD-ROM: 
\Sample Programs\TK-850_Jx3-E_IAR_mailSample\Program Files\NEC Electronics 
Tools\smp850e\cnet\TK-850_Jx3-E\OSless 
 
This directory of the sample programs contains the project including all output files of the development tool. 
The workspace file “cnet.eww” is located in this directory and includes the project from which all the sample 
programs can be run.  
 
As an alternative to open the sample-workspace project file “<name>.ewp” can be added to any user 
created workspace. 
 
The source code of the sample programs uses the following directory structure: 
 

 fs Web server contents 

 include C header files 

 OSless Demonstration sample project directory 

  Debug  Debug output files for IAR C-SPY debugger 

  Release  Output files for Flash programming purpose 

  settings  Configuration files, IAR Embedded Workbench 

  cnet.dep  Dependency information file, IAR Embedded Workbench 

  cnet.ewd  Project setting file, IAR C-SPY debugger 

  cnet.ewp  Project file, IAR Embedded Workbench 

 cnet.eww  Workspace file, IAR Embedded Workbench 

  io70f3760.ddf  DDF file 

  io70f3760.sfr  SFR file 

  lnk70f3760.xcl  Linker control file 

 src C source files 

Table 13: Sample Directory Structure 

 
The \OSless directory contains the project files for the IAR Systems Embedded Workbench for NEC V850 
as well as the device definition, SFR and linker control files of the uPD70F3783 device. All source files are 
located in the directory \src. The \include directory contains the header files. All output files including 
the object files, list files, debug information and finally the executable file are stored in the directory \Debug 
or \Release. 
 
For details of using the IAR Embedded Workbench and the IAR C-SPY debugger please refer to the “V850 
IAR Embedded Workbench IDE User Guide”. 
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11.2 Sample Programs overview 

 
The Ethernet sample programs consist of a HTTP web server, which is used to configure a POP3/SMTP e-
mail client and to control a 7-segment LED, and a DHCP client. 
 
To operate these sample programs, the V850ES/Jx3-E - Network it! board must be connected to the 
Ethernet port of a PC. The connection is detailed in the next section. 
 
 

Ethernet Samples Programs 

Web server 
A HTTP web server running with a web browser is used to 
configure the settings of the e-mail sample applications and to 
control the on-board 7-segment LED 

E-mail client 
POP3/SMTP protocols are used to demonstrate e-mail 
functionality 

DHCP client DHCP protocol is used for dynamic IP address allocation 

7-Seg. LED 
7-Seg. LED which is mounted on the V850ES/Jx3-E - Network 
it! board 

Table 14: Ethernet Sample Programs Description 

 
 
The sample programs can be used according to the following procedure: 
 

 Sample Programs 
Installation 

Setting up of the 
Development Environment 

Execution of the  
Sample Applications: 

  => POP3/SMTP e-mail 
  => DHCP 
  => 7-Seg. LED 

Definition of the Settings 
using the HTTP web server 

Programmation of the board 
with WriteEZ5 

 
 

Figure 36: Sample Programs Procedure 

 
 
Once you have programmed the V850ES/Jx3-E - Network it! board with the sample programs provided in 
the hex file (web_server_no_DHCP_192_168_0_5.hex) using WriteEZ5, please refer to the next sections 
to find out how to launch and use them. 
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11.3 HTTP web server 

 

11.3.1 Development environment 
 
Prior to use the HTTP web server sample program, the development environment must be set according to 
the following points. 
 

1. Use the settings displayed in the tables below for the switch SW1 and the power supply jumper 
JP1 of the V850ES/Jx3-E - Network it! board. 

 
 

SW1 / bit Configuration: 
Stand alone mode 

1 OFF 
2 OFF 
3 OFF 
4 ON 

 
 

JP1 Power Supply Source 

1-2 short USB connector USB1 
 
 
Note:  Use these same settings for SW1 and JP1 for every sample program. Optionally, you can 

supply the board using an external power supply plugged in the connector CN4. In that case 
you need to move the jumper JP1 on the 5-6 position. 

 
 
 
 

 
Figure 37: Location of Switches and LEDs 

 
 
 

2. Plug the Ethernet RJ45 cable (category 5) between the Ethernet connector of the V850ES/Jx3-
E - Network it! board and the Ethernet port of the host PC. Please use an RJ45 cross cable 
when connecting the board directly to the host PC. 
 

3. Connect the USB cable to the V850ES/Jx3-E - Network it! board. The power is applied to the 
microcontroller as soon as the USB cable is plugged, there is no power switch. 
 

Power LED 

LAN LED 

Reset SW 

SW1 

JP1 
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Figure 38: V850ES/Jx3-E - Network it! Board Connected 

11.3.2 How to run the sample program 
 
After having connected the host PC to the V850ES/Jx3-E - Network it! board and having open the HTTP web 
server via a web browser, this HTTP web server can then be used to see or setup the parameters of the 
network. To do so, please follow the instructions below: 

 
1. The program is automatically booted and the HTTP web server starts as soon as the power 

supply is applied to the board. 
 
2. On you host PC, open the Windows “Start” menu > “Connect to” > “Show all connections”, then 

do a right click on your network connection and select “Properties”. Under the General tab, 
select “Internet Protocol TCP/IP” and click on the “Properties” button. From the displayed 
window, select “Use the following IP address”, enter the following settings and click OK: 
 
IP Address: 192.168.0.10 
Subnet mask: 255.255.255.0 

 

 
Figure 39: Host PC IP Address Configuration 

 
 

3. Open your favorite web browser on the host PC, and type the following address in the URL bar 
to connect to the HTTP web server of the V850ES/Jx3-E - Network it! board: 
http://192.168.0.5 

http://192.168.0.5/
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Note:  The IP address of the board can be changed in the “config.h” header file located on 
the \include directory of the sample programs. The variable to modify is 
“CONFIG_MY_IPADDRESS”. 
The MAC address has to be written to address 0x0007FFF8 of the internal Flash (see 
\src\driver\ether_tk850_jh3e_net.c). 

 
 

4. The main page of the HTTP web server will be displayed: 

 
Figure 40: HTTP Web Server Main Page 

 
 

5. The available menu is split into three main sections, which are Information, Setup and Sample 
API.  

 
In the Information section, in addition of the CPU specifications and the board specifications, 
you can also access the Network interface subsection. This subsection displays the actual 
settings of your network configuration: 
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Figure 41: Network Interface Information Page 

 
6. Still in the Information section, the last subsection gives you the Network library version: 

 

 
Figure 42: Network Library Version Information Page 

 
 

7. The Setup section consists of Network and Mail server setting pages, as well as a Parameter 
saving page to write the parameters saved in these two setting pages to the Flash memory. 

 
You can use the Network setting page to configure the IP address, the Subnet mask and the 
Gateway: 
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Figure 43: Network Setting Page 

 
 

8. The Mail server setting page below is used to configure the e-mail server functionality. 
 

 
The following settings are available: 
 
• The IP address of the SMTP server (Example: 192.168.0.254). 
• The receive mail address that specifies the e-mail address to which the incoming e-mails 

arrive. 
• The forwarding mail address that specifies the e-mail address used to automatically forward 

the outcoming e-mails to the recipient. 
• The IP address of the POP3 server (Example: 192.168.0.254). 
• The account and the password of the POP3 server that are needed to collect the e-mails 

received to the V850ES/Jx3-E - Network it! board. 
• The Mail acquisition interval that defines the time interval used to check the POP3 server to 

determine whether there are confirmations of new e-mails received. Please reduce the 
acquisition interval value when the load of e-mails on the POP3 server increases. 

 
Finish by pressing the “Setting” button to save the new parameters. 
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Figure 44: Mail Server Setting Page 

 
 

9. Please note that the Parameter Saving (Writing in the Flash ROM) option is not implemented. 
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Figure 45: Parameter Saving Page 

 
 

11.4 SMTP/POP3 e-mail server 

 
The SMTP/POP3 e-mail server is the second sample program. Before executing it, it is necessary to 
properly configure your network using the HTTP web server described in the previous section. 
 
This sample program brings e-mail functionality (via POP3 and SMTP protocols) to the V850ES/Jx3-E - 
Network it! board and performs the following tasks: 
 

1. Confirmation of new e-mails to the POP3 e-mail server. 
2. Collection of the new e-mails using the POP function. 
3. Sending e-mails using the SMTP function according to the content of the e-mail received  

=> The e-mail received is forwarded to a specific address. 
4. Steps 1 to 3 are repeated at the interval set up using the Mail server setting page on the HTTP web 

server. 
 
The corresponding sample code follows the software flowchart below: 
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Mail reception processing start 

(Set function Web screen) 

Mail reception 
（cnet_pop3getmsgxxx） 

Yes
No 

Mail sample application 

“FWD”

Mail forwarding 
The mail text is transmitted 

(SMTP) 

Mail confirmation 
（cnet_pop３ｓｔａｔ） 

Mail reception beginning 
(cnet_pop3init) 

POP attestation
（cnet_pop3auth） 

Mail reception end 
(cnet_pop3end) 

Timeout

No forwarding 

start 

Others

Mail deletion 
（cnet_pop3delete） 

Mail acquisition timer set

Has mail reached? 

Command on the first line of the mail?

 
Figure 46: Mail Sample Application Flowchart 

 
 

11.4.1 Development environment 
 
 
The following schematic describes the specific development environment you need to setup in order to 
benefit from the e-mail functionality. 
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USB cable 

Ethernet 

straight cables 

Mail server 

+ DHCP server (opt.) 

PC 
V850ES/Jx3-E 

Network it! board 
Network Hub 

When power supply via USB 
 

Figure 47: Connection Schematic to the E-mail Server 

 
 

11.4.2 How to run the sample program 
 
 
In order to run the e-mail sample program, please ensure that these different steps are correctly 
implemented:  
 

1. Connect the V850ES/Jx3-E - Network it! board to an Ethernet network hub via a RJ45 straight-
through cable, according to the connection schematic above.  

 
2. Similarly, connect the PC, with the web browser, to the Ethernet network hub using a RJ45 straight-

through cable. Also connect the USB cable between the V850ES/Jx3-E - Network it! board and the 
PC to supply the board. 

 
3. Connect the mail server (PC) to the network hub with a straight-through cable. 

 
4. The web browser on the PC is used to set the SMTP/POP3 e-mail server parameters. The mail 

reception processing is started once you have pressed the “Start” button on the Mail setting page 
displayed on your web browser. 
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Figure 48: Start Button for Mail Reception Processing 

 
 

5. When failing to connect to the POP3 server, please check the settings of the different addresses and 
POP3 account/password. 

 
6. The V850ES/Jx3-E - Network it! board receives the e-mails from the POP3 server and these e-mails 

are transmitted to the user specified by the POP3 server account according to the command on the 
first line of the text.  

 
Please use the following format for the e-mails. 

 
  To: ******@***.***.com    ← E-Mail address of the POP3 user 

Subject: ******   ← The content is arbitrary (Up to 10 characters) 
（The first line of text）     ← Command 
（The second line of text） 
   ：          ← When the mail is forwarded, the transmitted content is 

   described 
 
（up to 10 lines） 

 
 
 Command on the first line of the e-mail: 

 
[FWD] 
If the command forward, “FWD”, is entered, the e-mail is forwarded from the second line of the 
text to the address specified in the Mail server setting web page. 
 
[(Others)] 
E-mails that don't contain the “FWD” command on the first line of the text are deleted without 
doing any specific operation. 
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11.5 DHCP client 

 
The V850ES/Jx3-E - Network it! board can also benefit from Dynamic Host Configuration Protocol. 
 
To enable DHCP, set the variable “CONFIG_DHCP” to 1 as shown in the screenshot below. 
 
This variable can be found in the header file “config.h” located under the following directory: 
\Sample Programs\TK-850_Jx3-E_IAR_mailSample\Program Files\NEC Electronics 
Tools\smp850e\cnet\TK-850_Jx3-E\include 
 
 

 
Figure 49: Variable “CONFIG_DHCP” for DHCP Activation 
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11.6 7-segment LED control 

 
This sample program performs the control of an on-board 7-segment LED by displaying different numbers.  
Similarly to the e-mail sample program, the 7-segment LED mounted on the V850ES/Jx3-E - Network it! 
board can be controlled using the HTTP web server running with a web browser. 
 

 
Figure 50: 7-Segment LED Location 

 
The corresponding sample code follows the software flowchart below: 
 

 
Set function Web Browser 

7-Seg. LED Operation Selection 

7-Seg．LED Sample Application 

Display selected number 

start 

7-Seg．LED Operation 

Web screen display 

Is it ON? 

Leave the web page 

End 

Which number？
Setting 

End

Re-input

No specification.

7-Segment LED Pattern 

Selection 

 
Figure 51: 7-Segment LED Control Flowchart 
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11.6.1 Development environment 
 
The following schematic describes the specific development environment you need to setup in order to 
control the 7-segment LED. 
 

 

 
Ethernet cross cable 

PC 

When power supply via USB 
USB cable 

V850ES/Jx3-E 

Network it! board 

 
Figure 52: Connection Schematic for 7-Segment LED Control 

 

11.6.2 How to run the sample program 
 

1. Connect the V850ES/Jx3-E - Network it! board to the PC, that will run the web browser, via an 
Ethernet RJ45 cross cable. 

 
2. Also connect the USB cable between the V850ES/Jx3-E - Network it! board and the PC to power the 

board. 
 

3. Open the web browser on the PC. Type the following address in the URL bar to connect to the 
HTTP web server of the V850ES/Jx3-E - Network it! board: 
 http://192.168.0.5/ 

 

 
Figure 53: 7-Segment LED Control via the HTTP Web Server 

http://192.168.0.5/
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4. The 7-segment LED control page is displayed. 
 
 

 
 Figure 54: 7-Segment LED Control Page 

 
 

5. Select the number you wish to display on the 7-segment LED using the drop-down menu. 
 

6. Press the “Setting” button to apply the changes on the board. 
 

7. The corresponding numbers is displayed on the on-board 7-segment LED, and is maintained until 
the next number change. 

 
8. Please repeat steps 5 to 7 to continue selecting different numbers. 
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12. Cables 
 

12.1 USB interface cable (Mini-B type) 

 

 

Figure 55: USB Interface Cable (Mini-B type) 
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Figure 60: V850ES/Jx3-E - Network it! Schematics 5/5 
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